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Notations Used in This Guide

Safety Symbols
The projector and its manuals use graphical symbols and labels to indicate content that tells you how to use the product safely.

Read and carefully follow the instructions that are marked with these symbols and labels to avoid injury to persons or damage to property.

This symbol indicates information that, if ignored, could possibly result in personal injury or even death.

A Warning

This symbol indicates information that, if ignored, could possibly result in personal injury or physical damage due to incorrect handling.

/A Caution

General Information Notations

This label indicates procedures that may result in damage or injury if sufficient care is not taken.
Attention
This label indicates additional information that may be useful to know.
[Button name] Indicates the name of the buttons on the remote control or the control panel.
Example: [Esc] button
Menu/Setting name Indicates projector menu and setting names.
Example:
Select the Image menu
@ Image > Advanced
» This label indicates links to the related pages.
- This label indicates the projector's current menu level.

» Related Links
« "Using the Manual to Search for Information” p.5



Using the Manual to Search for Information

The PDF manual allows you to search for information you are looking for by

« Mac OS: Hold down the command key, and then press <.
keyword, or jump directly to specific sections using the bookmarks. You can

also print only the pages you need. This section explains how to use a PDF = . o

manual that has been opened in Adobe Reader X on your computer. ® Y Ee@T

» Related Links EPSON

« "Searching by Keyword" p.5

« "Jumping Directly from Bookmarks" p.5

« "Printing Only the Pages You Need" p.5 User's Guide

Searching by Keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you r—

want to find in the search window, and then click Search. Hits are displayed Printing Only the Pages You Need

as a list. Click one of the displayed hits to jump to that page.

o You can extract and print only the pages you need. Click Print in the File
. . il '_“;‘_ . menu, and then specify the pages you want to print in Pages in Pages to

“ N8a R — Print.
5 EPSON crsl .“’E’:‘”"‘“’” « To specify a series of pages, enter a hyphen between the start page and the
. : — - end page.
= = - (s S—— Example: 20-25
e | UsersGt T Ve s o To specify pages that are not in series, divide the pages with commas.
p T et Example: 5, 10, 15
A.I.— . | %Mfﬂ"wﬂyﬁ.‘-wwﬂ—'rh
Prigher: - o Rrepetien | Aduanced te @
Copee I 2 gnmmvm:-km_ut-uwu:
Jumping Directly from Bookmarks s ok n
Pages ,m— Susreriaree e )

Click a title to jump to that page. Click + or > to view the lower level titles in i ) o A
that section. To return to the previous page, perform the following operation e | ™ I"""—l
on your keyboard.

« Windows: Hold down Alt, and then press <.



Introduction to the Epson Projector Management Software

See the information here to learn more about the Epson Projector Management software.

» Related Links
« "Epson Projector Management Features" p.7



Epson Projector Management Features

The Epson Projector Management software allows you to check the status of
multiple networked projectors and perform various projector operations from
your computer.

« Monitoring the status of projectors
You can visually check projector information such as power status, errors,
and warnings so you are alerted to projector abnormalities immediately.
You can also select individual projectors or projector groups to check
detailed information such as the usage hours of the projector light source,
the current input source, and any current errors or warnings.

« Controlling the projectors
You can turn projectors on or off, or change input sources for individual
projectors or projector groups. You can schedule various projector events to
occur automatically on the specified date and time.

« Updating the projector firmware
You can update firmware for a projector over a wired network. When new
firmware is available, you see a notification on the software screen. You can
then download the firmware to your computer and update your product
firmware right away, or schedule when you want the firmware update to
occur.

« Copying the projector menu settings
Once you select a projector's menu settings, you can copy the settings to
multiple projectors of the same type in a batch setup operation.

« Sending email notification
You can configure the software to send you an email alert if there is a
problem with the projector or the software detects that the registered
projector has been replaced with a different one.

 Message Broadcasting
You can distribute images or text messages to multiple projectors for
simultaneous display on those projectors.

« Monitoring and controlling non-Epson projectors using the PJLink protocol
You can monitor and control projectors that support the PJLink protocol.

» Related Links
« "Copying Projector Menu Settings in a Batch" p.29
« "Monitoring Projectors” p.18

"Controlling Projectors" p.22

"Sending Email Notifications" p.36

"Updating the Firmware" p.25

"Message Broadcasting" p.37

"PJLink Monitoring and Control Limitations" p.63



Setting Up the Software for the First Time

Follow these instructions before connecting a computer to the projector over a network.

» Related Links
« "Installing the Software" p.9
« "Selecting Projector Network Settings" p.11



Installing the Software

Check the system requirements necessary to run the software, and then install

the software.

If the language selected for the installation differs from the language of

the operating system being used, the screens may not display correctly.

» Related Links

« "System Requirements” p.9

« "Installing the Epson Projector Management Software" p.9
« "Importing Settings From EasyMP Monitor" p.9

System Requirements

This application supports the following operating systems, and is compatible
with computers that meet the following system requirements.

Windows 8.1

o Windows 8.1 (32- and 64-bit)

« Windows 8.1 Pro (32- and 64-bit)

o Windows 8.1 Enterprise (32- and 64-bit)

Operating Systems

Windows 10

« Windows 10 Home (32- and 64-bit)

« Windows 10 Pro (32- and 64-bit)

o Windows 10 Enterprise (32- and 64-bit)

Installing the Epson Projector Management Software

Download and install the Epson Projector Management software on your
computer.

Visit epson.sn to download the latest version of the Epson Projector
Management software.

 You need administrator authority to install the Epson Projector

Management software.

* You need to install Microsoft NET Framework 4.5 before installing
the Epson Projector Management software.

« While installing the Epson Projector Management software, you may
need to install other required software such as Microsoft SQL Server
2014 SP3 Express. Follow the on-screen instructions to continue
installation.

n Download the latest version of the Epson Projector Management
software.

a Double-click Epson Projector Management Ver.X.XX.exe to start the
installer.

B Follow the on-screen instructions.

CPU Intel Core i5 or faster
(Intel Core i7 or faster reccommended)

Memory 2 GB or more
(16 GB or more recommended)

Hard Disk Space 1 GB or more

Display Resolution between 1280 x 800 (WXGA) and
1920 x 1200 (WUXGA)

16-bit color or greater (approximately 32,000 display
colors)

Importing Settings From EasyMP Monitor

You can transfer setting information from the EasyMP Monitor software
(version 4.50 or later). Start the Epson Projector Management software on the
same computer and the settings are imported automatically the first time you
start the software. When finished, you see an message telling you that the
settings are imported.

If you want to use the imported settings on another computer that is running
the Epson Projector Management software, you can save a configuration file
on the original computer using the Save Configuration File feature on the


http://www.epson.sn

Installing the Software

Environment setup screen. Then copy the resulting configuration file to the
following directory on the other computer.

C:\ProgramData\SEIKO EPSON CORPORATION\Epson Projector
Management

» Related Links
« "Environment Setup - General" p.58



Selecting Projector Network Settings

Follow these instructions to select a connection method between a computer
and the projector, and then set up the projector.

Connect the projector to your network using the Advanced connection mode.

To update the projector firmware or copy the projector settings, connect the
projector using a wired network system.

» Related Links

« "Setting Up a Projector to Connect in Advanced Connection Mode (Wired)"
p-11

« "Setting Up a Projector to Connect in Advanced Connection Mode
(Wireless)" p.11

Setting Up a Projector to Connect in Advanced
Connection Mode (Wired)

To connect a computer to the projector using a wired LAN, you need to select
network settings on the computer and the projector.

n Connect the computer to the network.
@ To set up a network connection, if necessary, see the
documentation supplied with your computer or network adapter.
Connect a LAN cable to the projector.

Turn on the projector.

Press the [Menu] button on the remote control or the control panel,
and select the Network menu.

SRWEN

Select these IP settings for your wired LAN as necessary.
« DHCP is available: Set DHCP to On.

« DHCP is not available: Set DHCP to Off and enter the projector's IP
Address, Subnet Mask, and Gateway Address values as necessary.

When you have finished selecting settings, save your settings and exit
the menus.

» Related Links
« "Solutions When You Cannot Find Connected Projectors (Wired)" p.45

Setting Up a Projector to Connect in Advanced
Connection Mode (Wireless)

To connect a computer to the projector over a wireless LAN, you need to
select network settings on the computer and the projector.

@ The necessary settings vary depending on your projector. See your
projector User’s Guide for instructions.

n Contact your network administrator and write down the settings for the
access point, such as the SSID and security settings.

a Connect the computer to the network.
@ To set up a network connection, if necessary, see the
documentation supplied with your computer or network adapter.
Install the wireless LAN unit in the projector, if necessary. See your
projector User's Guide for instructions.

Turn on the projector.

Press the [Menu] button on the remote control or the control panel,
and select the Network menu.

QOO0 ®

Turn on wireless LAN support.



Selecting Projector Network Settings

9
10

Select one of these settings to connect the projector to a wireless LAN.
The necessary settings vary depending on your projector.

« Turn off the Simple AP setting.

o Select Advanced for Connection Mode.

Select other options as necessary for your network. See your projector
User's Guide for instructions.

Select security settings as necessary for your network. Check with your
network administrator for more information on choosing the correct
settings.

When you have finished selecting settings, save your settings and exit
the menus.

» Related Links
« "Solutions When You Cannot Find Connected Projectors (Wireless)" p.45



Registering the Projectors

Follow the instructions here to register your projectors for management on a network.

» Related Links
« "Registering Projectors for Monitoring" p.14



Registering Projectors for Monitoring

To manage projectors, you must register the projectors to the Epson Projector B Select a search mode.
Management software. Once registered, the projector status is automatically
displayed when you start the Epson Projector Management software. B pirsase e

Search Edit Projector Information

If you need to register a large number of projectors, you can create projector Sew o
groups so you can monitor and control the projectors in small units. B

Display name
Projector name
teoms [ [seea |

N Group [seiean |

You can register up to 2000 projectors and groups in total. To monitor a large
number of projectors, make sure your computer meets or exceeds the system
requirements.

1 Projector ame 1P sddress

» Related Links S

« "Searching for Projectors” p.14

« "Creating a Projector Group" p.16

- Syetem Requitaments” 59 o Select ?(utomatic search to search for the projector on the same
network.

o Select Manual search to search for the projector by specifying the IP
address. Enter an IP address.

Searching for Projectors
« Select Range search to search for the projector by setting an IP

You can search for projectors on the same segment automatically or search address range. Enter an IP address in Start IP address and End IP
for projectors by specifying an IP address. address.
n Start the Epson Projector Management software. @ If you want to search non-Epson projectors that support PJLink
. . Class2 automatically, select Search for Projectors in PJLink
« Windows 8.1: Navigate to the Apps screen and select Epson (Class2).

Projector Management Ver.X.XX.

« Windows 10: Select Start, select EPSON Projector, and then select ]
Epson Projector Management Ver.X.XX. Click Search.

The Epson Projector Management software starts. You see a list of network projectors.

Select Projector from the menu bar and select Projector Registration.

The Projector Registration screen appears.



Registering Projectors for Monitoring

B Select the projector that you want to register. (@ Enter notes about the projector, such as its location, if necessary. Notes
entered here are displayed in Projector properties. You can enter up to
Fop— o 60 characters.
Search Edet Projector Information
Sewreh Mode ey - @ 1If a password has been set for the projector, enter the password here. If
[ S o et Pk €k P e _ _ you do not enter the correct password, you cannot monitor or control the
[T | e = == projector, even after registering the projector. For more information
e m— 2 isdsiind . about passwords, see your projector User's Guide.
] OCOOCOCO00M 00K 000 2008 300 Descriptisn
] 3000000000 R 00
] MCO0000000 00 3000 3008 W0

passwerd ()

- Click Register.

B To register additional projectors, repeat steps 5 to 7.

B Select the necessary settings for each projector.
You see the registered projectors in the Epson Projector Management main
I screen.

Edit Projector Information

o r i @ « To change the projector information for a registered projector,
play name . X : . :
) ) double-click the projector in the Epson Projector Management main

screen, and then change the necessary information on the Projector

— s (0] properties screen.

— Group name No Group « To remove a registered projector, right-click the projector in the
Epson Projector Management main screen, and then select Delete.

e Projector name

| address

» You may see a message prompting you to set the Standby Mode
setting to Communication On in the projector's menu. Select Yes to
monitor projectors while the projector is in standby mode (when the
power is off).

Register | « In a DHCP-enabled network, you can register and manage any
projector that is detected using Automatic search.

— Description

— Pzssword @

Enter the name of the projector. This name is displayed in the Epson » Related Links
Projector Management main screen. You can enter up to 64 characters. « "Projector Properties - Information" p.53
Displays the name that has been registered to the projector.

Select the icon.

Select a group if you want to register the projector to a group.

000 ©

Displays the projector's IP address.



Registering Projectors for Monitoring

Select the group in which you want to register the projector, and then

Creating a Projector Group click OK.

Registering projectors to a group allows you to monitor and control multiple

. - o T =
projectors all at once. When you select a parent group, you can also monitor [E’ il 'esl(m"m;tm?ml — — L]
. . . . eduie a nrarmaton ice
and control all projectors included in multiple groups. T W T W
Select Projector from the menu bar and select Group Registration. Display name HOO0KX 2]
The Group Registration screen appears. AT FOoRa
Icons - Select... |
a Select the necessary settings. Group name o000 [ sekect.. |
IP address EGTDUhVNﬂtES E i
i) Group Registration Kb ot houey Select a Group
Source H
Group Info LghtSource || «
| Constant Brightrie B xoo00xx
Display name Remains No Group
I % Temperature leve
— | CONS 2
Manufacturer
— (SrOUD Name SO0 Select... i
Description
i (i s
Status
@ Enter the name of the group. You can enter up to 64 characters. Monitor Password
@ Select the icon. ok | [ cancel

@) Select a parent group if you want to register a group to it. (You must
create the parent group before you can add groups to it.)

To verify the projectors included in the group, select the A Grouping

Click Register. . o

view icon on the main window.
You see the registered group in the Epson Projector Management main
screen. » Related Links

) ) ) ) « "Monitoring Projectors” p.18
ﬂ Double-click the projector icon that you want to register to the group.



Monitoring and Controlling the Projectors

Follow these instructions to monitor and control the registered projectors.

» Related Links

« "Monitoring Projectors” p.18

« "Displaying Projector Status Details" p.21
« "Controlling Projectors” p.22



Monitoring Projectors

Click the view icons on the Epson Projector Management main screen to
select the type of the monitoring window you want to view.

. Detail list view
You can check projector status as a list. To check the status of projectors in
a specific group, select the group in the Group List.

Bl Proctsr e Tool
] = P o
o o e e e
i T =
R 00000 [ e — e | m— [ B
e [ crcenes — o i e
! XOOK oo —_ wonoees
[ e
[ oo o
ey
. Grouping view

You can check projector groups in a hierarchical diagram.

When you want to expand or collapse a group, double-click the group icon
or a group name in the Group List. When the projectors in the group are
hidden, the group icon appears with a circle frame.

To move the position of the group icon, drag and drop the group icon.

Eie Pajecor Eot oo

+ 100%

Keyboard Shortcuts

You can use the following keyboard commands:
Keyboard command Function
Ctrl + [+] Enlarges the view.

Ctrl + scrolling the mouse wheel up

Ctrl + [-] Reduces the view.

Ctrl + scrolling the mouse wheel
down

. 0 Error list

You can check a list of only the projectors that are currently in an error or
warning status. To check the status of projectors in a specific group, select



Monitoring Projectors

the group in the Group List. To view solution, move the pointer over the %« To change the displayed item or order in the Detail list view and
error information. $ Error list, change the Display List setting on the Environment
__________ . S setup screen.
o S . — + To enable or disable monitoring, right-click the projector to select
<= 2Bl & o oot~ Monitoring enabled or Monitoring disabled in the Epson Projector
oo - : el i o S ”, = e Management main screen.
Wb e ey — « To monitor projectors even when they are in standby mode (when

power is off), select Communication On as the Standby Mode
setting in the projector's menu. Also select the correct Port setting, if
necessary.

» Related Links
« "Viewing Projector Temperature Graphs" p.19

Viewing Projector Temperature Graphs

Seected 0 (3 Twes

You can view temperature information of projectors graphically.

‘ Right-click the projector in the Detail list view and select Temperature
. Update List history.
You can manage projector firmware updates.
e e 2018/09/18 - 2018/09/18 save... | —9
<« E & R ﬂ Q| | Poeris, AV e Sorce ¥ = Air Temy
— e == = o - Gu:r-vlsed Operation Temp T
. f:":::" i I;'.;vu GrouUD name Display name Pa mawmw- § -SQ!M-- ] 1l
1 000000t N 000000 o < [ ooooo —
Ha Group oo 000000 5l [ — E 40 i -
g 3 Warring 5
Update
o =1 omas
) [ —
e " . — o
s-u-w:hu " (D _IE|I i 200 040 2800 1290 s ' = r_G'

Sected 1/ 2 Hems




Monitoring Projectors

@ Background color
Blue: Requires immediate attention.
Yellow: Warning status
Red: Error status

@ Switches the view between Celsius and Fahrenheit.
@ Zooms into or out of the graph.
@ Saves the temperature history in a CSV format file.

You can pan around the graph by holding down the right mouse button at
any point on the graph and moving the mouse right or left.

 You can view the temperature information for a maximum of 30
days.

o Temperature information is obtained only while the Epson Projector
Management software is running.

« The indicated value in the graph may not match the actual
temperature. Use the value as a guide. See your projector User's
Guide for details on the projector's operating temperature.

« You can view graphs for up to 4 projectors at a time.
« This function is available only for supported models.



Displaying Projector Status Details

You can check detailed projector status information on the Projector « Status Information: Displays projector status information.

properties screen. « Service: Displays technical service information. (Normally used only

by Epson Support.)
On the Epson Projector Management main screen, double-click the

rojector you want to check.
p1o) youw You can check and edit projector information for multiple

projectors at one time. Select projectors on the main screen,
right-click them, and select Property.

The Projector properties screen appears.

ﬁ o TR =l ) )
‘ Schedule | Status Information | Service = Projector properties (2 items}) ﬁ
Information | Status History | Usage History Information |

Display name SOOO00CL [Hs} e - T

Projector name T Group name W|

Icons - Select... | Destiption

Group name No Group Select...

Monitor Password
1P address
Light source hours used ~ -——-
Conce
Source i <
K

Light Source

Constant Brightness
Remains

Temperaturs level

» Related Links

Manufacturer

o « "Projector Properties Screen” p.53
Description T I
Status Natwork error (TCP connection error)
Monitor Password
Cancel |

a Click tabs to check each type of information.
« Information: Displays general projector information.
« Status History: Displays the projector's error history.
« Usage History: Displays the projector usage history as a graph.

+ Schedule: Displays the schedule set for the projector or the
projector's parent group.



Controlling Projectors

You can control the selected projector by using the projector control buttons a Click the projector control buttons to perform the following operations.
on the Epson Projector Management main screen.
On the Epson Projector Management main screen, select the projector ] = N
you want to control. You can select multiple projectors or all projectors = 1 e
by selecting checkboxes as necessary. o S —
! e
JEN s m o
2 o i i i e
¥ raocoo: m o [ s [
o Grop W oo iy Q = i, oo
! e wonoees
B oocox e Y f—
W oo - @ e

« 2 Refresh: Updates the projector information.

» Power: Turns the projector on or off.

o A/V Mute: Turns the projector's A/V Mute or Shutter feature on or
off.

« Source: Switches the projector's input source. (Available only for
Epson projectors.)

B Right-click the Epson projector in the list to perform the following
operations.

« Web control: Allows you to select projector settings and control
projection using a Web browser.

« Remote Camera Access: Allows you to check the image captured
with the projector's remote camera using a Web browser.

+ Auto Setup: Allows you to use the projector's auto setup feature such
as Color Calibration or Screen Matching. You can also select
Cancel Refresh Mode.



Controlling Projectors

o The Power, A/V Mute, and Source operations are not

available while using the Auto Setup feature.

« See your projector User's Guide for details on the Remote
Camera Access and the Auto Setup features, if available.



Updating Firmware and Copying Menu Settings

Follow the instructions here to update your projectors to use the latest firmware or copy the projector's menu settings.

» Related Links
« "Updating the Firmware" p.25
« "Copying Projector Menu Settings in a Batch" p.29



Updating the Firmware

You can update firmware for a projector over a wired network. New firmware
is distributed over the network or you can download it from Epson support
center. You can then update the firmware right away or schedule when you
want the firmware update to occur.

$ « When you select Enable to receive information about firmware
updates, the software checks the firmware update information
automatically in every 14 days.

« When you check the firmware update information immediately,

When you update the firmware, make sure of the following: select Check.
« The projector is connected using a wired network system.
o The projector is turned on or the projector's Standby Mode is set to Click the Update List icon on the Epson Projector Management main
Communication On. screen to open the Update List view.
A o) 1B Epeon Prayeceor Managemen bei0ck - 0o x
Caution
g q q ¢« =H A =] n D) Possrw AVMiesr Soemrw
+ You cannot use the projector while updating the firmware. —— = = =
+ Do not unplug the projector's power cord while updating the firmware. If the . H:&Tm*;“ i e R ——
projector unexpectedly shuts down while updating, the firmware may not be s G ER R T ere— -
written correctly, which could cause the projector to malfunction. Epson takes
no responsibility for firmware update failures and associated repair costs due to et
power outages, communication errors, or other problems that may cause such Fo
failures. oot
« Do not update firmware when the projector is performing any other operation. e
» Related Links
« "Updating to New Firmware Found on a Network" p.25
« "Updating to New Firmware Downloaded to Your Computer” p.26 e

- - When you see Firmware Update Information in the Status column of
Updatlng to New Firmware Found on a Network the left pane, you can update these projectors.

When a new firmware is available, you see a notification on the main screen

%  You can view the release notes for the new firmware by right-
and you can schedule when to update the firmware. @ clicking Firmware Release Notes.

To receive notification of firmware updates, do the following:
« Start the Epson Projector Management software.

« Select Tool from the menu bar and select Environment setup > Monitor
tab > Enable to receive information about firmware updates.

o Check the network Proxy Settings options on the Monitor tab and change
them if necessary.



Updating the Firmware

Select the projector you want to update. You can select multiple The firmware is updated at the date and time you set, and the LED indicator
projectors or all projectors by selecting checkboxes as necessary. on the projector turns on. When the firmware update is complete, the
projector turns off and it enters standby mode. While updating, you can check
i ol the firmware update status on the right pane of the Update List view.
¢ B A = u ) Powers AVMiser Sourew
WFE3 [eare | Ueewe o : @ « Do not close the Epson Projector Management software while
e ; e~ S— R R updating the firmware.
s G | R i e Ismasion 1=

o If you try to close the Epson Projector Management software when

there is a scheduled update standing by, a confirmation message is
e displayed. Scheduled updates are executed only while the Epson
Projector Management software is running.

— + You may need to reconfigure the projector's network settings after
- updating the firmware since the network settings may be changed by

the firmware update process.

Seacaed | /3 hems

Updating to New Firmware Downloaded to Your
Select one of the following methods to update the firmware. Computer

» Click Right Now to start the firmware update immediately. You can update the firmware by downloading the firmware file manually.

o Set the date and time you want to perform the firmware update, and

. Contact your nearest Epson support center for more information on
then click Schedule to schedule the update. Y P PP

acquiring your projector firmware.
The update schedule is displayed on the right pane of the Update List
view.

pane and click Edit.

o To delete the update schedule, select the schedule on the right
pane and click Delete.

o To change the update schedule, select the schedule on the right

 You can view up to 500 schedules on the right pane of the
Update List view. When the number of schedules exceeds 500,
schedules are deleted as necessary beginning with the oldest
schedule.

o To delete all completed schedules, right-click at any point on
the right pane and select Delete Old Schedules.



Updating the Firmware

Click the Update List icon on the Epson Projector Management main
screen to open the Update List view.

B Epson rojectir Management oo b
Fie Projector Bov Tool
= 4 = (P _——
Salect Fla Update List Fde Dot
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Click Select File to select the firmware file.

The File Information screen appears.

2. File Information 3]
File Information
Type |Projector Firmware |
Model EPSON XXXXXX Series |
Version BOCKXXX |
Sub-version | |

B Confirm the file information and click Close.

Projectors that can be updated by using this firmware file appear in the
left pane of the Update List view.

Select the projector you want to update. You can select multiple
projectors or all projectors by selecting checkboxes as necessary.
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Select one of the following methods to update the firmware.
« Click Right Now to start the firmware update immediately.

o Set the date and time you want to perform the firmware update, and
then click Schedule to schedule the update.

The update schedule is displayed on the right pane of the Update List
view.

$ To change the update schedule, select the schedule on the right
pane and click Edit.

To delete the update schedule, select the schedule on the right
pane and click Delete.

 You can view up to 500 schedules on the right pane of the
Update List view. When the number of schedules exceeds 500,

schedules are deleted as necessary beginning with the oldest
schedule.

o To delete all completed schedules, right-click at any point on
the right pane and select Delete Old Schedules.



Updating the Firmware

The firmware is updated at the date and time you set, and the LED indicator
on the projector turns on. When the firmware update is complete, the
projector turns off and it enters standby mode. While updating, you can check
the firmware update status on the right pane of the Update List view.

$ « Do not close the Epson Projector Management software while
updating the firmware.

o If you try to close the Epson Projector Management software when
there is a scheduled update standing by, a confirmation message is
displayed. Scheduled updates are executed only while the Epson
Projector Management software is running.

« You may need to reconfigure the projector's network settings after
updating the firmware since the network settings may be changed by
the firmware update process.



Copying Projector Menu Settings in a Batch

You can copy the menu settings from one projector to one or more other

projectors that are the same model and have the same firmware version. This

allows you to quickly duplicate projector menu settings in a batch setup
operation.

You can copy menu settings in a batch setup operation right away or schedule

a time to copy them.
When you copy the menu settings, make sure of the following:

o The projector is connected using a wired network system.

o The projector is turned on or the projector's Standby Mode is set to
Communication On.

Not all menu settings are copied to another projector, such as following.

 Network menu settings (except for the Mail menu and the Others menu)

o Lamp Hours and Status from the Info menu

Perform the batch setup operation before adjusting the image settings

such as Keystone. Image adjustment values are also applied to other
projectors and adjustments you made before performing the batch
setup operation are overwritten.

When you copy the menu settings from one projector to another, the
user's logo is also copied. Do not register any information that you do
not want to share between multiple projectors as a user's logo.

A\ Caution

 You cannot use the projector while copying projector menu settings in a batch.

o Do not unplug the projector's power cord while copying the menu settings. If the
projector unexpectedly shuts down while copying, the configuration may not be
written correctly, which could cause the projector to malfunction. Epson takes
no responsibility for batch setup failures and associated repair costs due to
power outages, communication errors, or other problems that may cause such
failures.

» Related Links
« "Downloading a Projector Configuration File" p.29
« "Copying a Projector Configuration File" p.30

Downloading a Projector Configuration File

You can download a configuration file containing the menu settings from a
projector so you can copy them to another projector.

Click the Update List icon on the Epson Projector Management main
screen to open the Update List view.
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On the left pane of the Update List view, right-click the projector from
which you want to copy the menu settings and select Acquire
Projector configuration data.

Select the folder to which you want to download the projector menu
configuration file.

Select one of the following options.
« Click Right Now to download the configuration file immediately.

« Set the date and time you want to download the configuration file,
and then click Schedule to schedule the download.

You can check the download status on the right pane of the Update
List view.



Copying Projector Menu Settings in a Batch

When the download is complete, the projector turns off and it enters The File Information screen appears.

standby mode.
22 File Inforrmation =
@ When you save the downloaded file to the USB flash drive and g )
. . . ile Information
copy the menu settings using it, make sure the file name
complies with the following conventions. Type Projector configuration data |
« Only single-byte characters are used. i
o The file name starts with "PJCONFDATA". Model [EPSON 200X Series |
Version DXHOOCK |
Sub-version | |
Copying a Projector Configuration File

After downloading a configuration file containing the menu settings from one
projector, you can copy the settings in the file to another projector.

B Confirm the file information and click Close.

Projectors that can be updated by using this configuration file appear
on the left pane of the Update List view.

Click the Update List icon on the Epson Projector Management main
screen to open the Update List view.
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a Click Select File to select the configuration file you have downloaded.



Copying Projector Menu Settings in a Batch

Select the projector to which you want to copy the configuration file.
You can select multiple projectors or all projectors by selecting the
checkboxes as necessary.
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Select one of the following methods to copy the menu settings.
« Click Right Now to start copying the menu settings immediately.

o Set the date and time you want to copy the settings, and then click
Schedule to schedule the update.

The update schedule is displayed on the right pane of the Update List
view.

@ « To change the copy schedule, select the schedule on the right
pane and click Edit.

o To delete the copy schedule, select the schedule on the right
pane and click Delete.

« You can view up to 500 schedules on the right pane of the
Update List view. When the number of schedules exceeds 500,
schedules are deleted as necessary beginning with the oldest
schedule.

o To delete all completed schedules, right-click at any point on
the right pane and select Delete Old Schedules.

The menu settings are copied at the date and time you set, and the LED
indicator on the projector turns on. When the process is complete, the
projector turns off and it enters standby mode. While copying, you can check
the menu copying status on the right pane of the Update List view.

« Do not close the Epson Projector Management software while

copying the menu settings.

o If you try to close the Epson Projector Management software when
there is a scheduled copy standing by, a confirmation message is
displayed. Scheduled copying operations are executed only while the
Epson Projector Management software is running.



Using Additional Functions

Follow the instructions here to use the additional functions available with the Epson Projector Management software.

» Related Links

« "Scheduling Projector Events" p.33

« "Making Security Settings" p.35

« "Sending Email Notifications" p.36

« "Message Broadcasting" p.37

« "Exporting a Profile for Epson iProjection Software" p.41
+ "Saving Projector Log Files" p.42

« "Updating the Registered Information" p.43



Scheduling Projector Events

You can schedule events to occur automatically on your projector. a Select the projectors or groups for which you want to schedule an

The projector performs the following operations on the specified date and event.
time in the schedule you set up. e =

o Power On/Off g Scngr
B3 X000 4 August, 2017 »
« A/V Mute b X00000K

S« Mo Tu We Th Fr Sa
No Groun 30 31 1 2 3

« Switching input sources s 7 8 s 1 u 1
13 14 15 16 17 18 19

o Message Broadcasting 0 2n 2 23 @ B %

27 29 30 31 1 2

« Auto Setup (Available only for projectors that support Color Calibration, S
Screen Matching, Light Source Calibration, or Refresh Mode.) i

Icons Display n-- Date Haour Control

You must also be running the Epson Projector Management software on your
computer at the scheduled time for the schedule events to occur.

@ You cannot schedule a firmware update on this screen. Schedule it in
the Update List view.

Co=)
Select Tool from the menu bar and select Schedule > Schedule
Settings.




Scheduling Projector Events

o To edit the event schedule, select the event in the Schedule Settings

operation you want performed. screen and select Edit.

Select the date and time for the scheduled event, then select the

« To remove a scheduled event, select the event in the Schedule

i Settings screen and select Delete.
splay name XOO000X
o To enable or disable the scheduled event without removing the
e scheduled event from the list, select the event in the Schedule
< E::;M Settings screen and select Enabled/Disabled.
) Every Day « To enable or disable all scheduled events, select Tool from the menu
Schedule bar, select Schedule, and then select Enable Schedule/Disable
_— ook [l Schedule.
» Related Links
Time {24 hour) XXX " . . "
« "Projector Properties - Schedule" p.55
o — « "Updating Firmware and Copying Menu Settings" p.24
®On
Off
(o« ][ comce |

@ o If you schedule an event that requires the projector to be
turned on, the projector turns on automatically, even if you do

not specify a power-on event.

o Before activating the Auto Setup feature, allow the projected
image to become steadily bright, without any flickering. Be
sure to select a power-on event prior to the Auto Setup event
to allow the projected image to become steadily bright.

o Turn on all projectors before using the Auto Setup feature. Be
sure to select a power-on event for all projectors on which you
want to use the Auto Setup feature.

B Select OK to save your settings.

The event schedule is saved.



Making Security Settings

You can improve the Epson Projector Management software security by
restricting access to the application and preventing anyone from changing its
settings.

» Related Links
« "Setting the Password" p.35
« "Restricting the Use of the Application" p.35

Setting the Password

You can set a password that must be entered when the application is started
or when the application lock function is enabled.

n Select Tool from the menu bar and select Environment setup.
a Select the General tab.

g Select Password.

%, Environment setup
General | Monitor | Display Llstl Mail ‘

[] Register at startup
[] Resident in the task tray

Set the projeCtor's Standby mode to Communication On when registering

Save Configuration File

==

Do one of the following.

o Create a password for the first time: Leave the Old password field
blank.

 Change an old password: Enter the existing password in the Old
password field.

B Enter a new password in the New password field. The password can be
up to 16 alphanumeric characters.

a Enter the same password again in the New password (confirm) field.

Click OK.

The password is saved.

Restricting the Use of the Application

You can lock the application functions so that they cannot be accessed by a
third party.

@ When you set a password, you need to enter the password to release
the application lock. Using a password improves the application
security.

Open the Tool menu, and then select Application lock.

The application is locked and no operations are available except for opening
and closing the application and disabling the application lock.

To unlock the application, open the Tool menu, and then select Application
unlock. If no password has been set, you can leave these fields blank and just
click OK in the window to enter the password.



Sending Email Notifications

You can configure the software to send you an email alert if there is a problem @ Enter the SMTP server name or IP address for the projector's SMTP
with the projector or the software detects that the registered projector has server.
beep rep.l aced Wl,t ha different one. The software can also send you a @ Select a number for the SMTP server port number using 1 to 65535.
notification email when the projector returns to normal status. :
Default is 25.
- o . @ Select to enable TLS authentication.
% o« Ifacritical problem causes a projector to shut down, you may not
receive an email alert. @ Select to enable SMTP authentication.
e The type of problems included in the email notification vary 6 Enter a user name for the SMTP authentication.
depending on your projector.
@ Enter a password for the SMTP authentication.
@ Enter the email address that you want to be identified as the sender. You
n Select Tool from the menu bar and select Environment setup. can enter up to 512 alphanumeric characters.

a Select the Mail tab. Select Add, select the recipient's email addresses, and then select the

) type of email notifications you want them to receive.
B Select any necessary settings.

Tt = B Select OK.
6

Essentbostes] Bistolli | The Environment setup screen appears. Repeat steps 4 to 5 to add
recipient's email addresses. You can register up to 10 email addresses.

[] Use Email Notification System

Mail Server

SMTP Server

Click Test Email.

i - If you do not receive the test email, check all of the settings on the Mail
tab for accuracy.

Part Number 25

rarget Email Address

E-mail Address

User name
rEassword ]
—_ Iisenaer il adress Select OK to save your settings.

» Related Links
o "Solutions When Network Alert Emails are not Received" p.47
« "Environment Setup - Mail" p.60

[ cones ]

@ Select to enable email notifications and allow you to enter the necessary
information.



Message Broadcasting

You can distribute images or text messages to multiple projectors for

simultaneous display on those projectors. You can distribute the information

immediately or at a specific date and time using the schedule feature.

@  Make sure the image file resolution is between 50 x 50 and 1920 x
1200 pixels.

o Make sure the text is 1024 characters or less.
A\ Caution

You should not rely on the Message Broadcasting feature to send urgent messages
in an emergency. Instead, use other methods for emergency notices. Epson does

not guarantee the speed, reliability, or accuracy of messages sent using the feature,
and Epson is not responsible for any loss, damage, or injury arising from its use.

» Related Links

« "Broadcasting a Message Immediately” p.37
« "Broadcasting a Message at a Specific Date and Time" p.38

Broadcasting a Message Immediately

You can distribute images or text messages to multiple projectors for
simultaneous display on those projectors immediately.

n Select Tool from the menu bar and select Message Broadcasting.

a Select the projector or group that you want to receive the distributed

message.
¥ Message Settings
P
e Display name  All projectors
4 [ 0000000 Py prel
v 8 0000008 Select Data to be Sent
No Group
) Folder
Update interval 5 | minutes
© Text A M= E=
Preview
B Select the type of information to distribute.
) Message Sattings
4 All projectors . -
Display name  All projectors
4 [ 0000 Py prel
i E ELIETRL Select Data to be Sent
No Group
(&) Folder
Update interval 5 *{ minutes
© Text A M EEF=E
Preview

« Select File to distribute one JPEG file.



Message Broadcasting

« Select Folder to distribute all JPEG files in the specified folder. a Select the projector or group that you want to receive the distributed
« Select Text to distribute a text message. message.
B schetie sexores Eie=—]
a Select the necessary settings. ——— <) Catercr
B3 X000 4 August, 2017 »
« When you select File, select Browse to specify the file to be R 00000 S om o owe ™ om s
distributed. — @ 7 5 b u o oB
13 14 15 16 17 18 19
« When you select Folder, select Browse to specify the folder that s B R
includes the files to be distributed. Specify an Update interval setting 5% 5 B 7 8 ®
from 1 to 30 minutes for automatically switching display from one e
image tO the neXt' Icons Display n-- Date Haour Control
« When you select Text, enter the message in the text box and select
any available style settings.
Select Start.
The images or text message you specified is projected by the selected
projectors or groups. —

@ The projector immediately stops projection from other sources
and switches to the distributed content.

B Select End to discontinue display of the distributed image or message.

Broadcasting a Message at a Specific Date and Time

You can distribute images or text messages to multiple projectors for
simultaneous display on those projectors at a specific date and time.

Select Tool from the menu bar and select Schedule > Schedule
Settings.



Message Broadcasting

Select the date and time for the message broadcast, then select Message B Select the type of information to distribute.
Broadcasting from Control.
¥ Message Settings
Display name  X000000(
Display name 000000
Select Data to be Sent
’; E::y Week ) Folder
) Evary Day Update interval 5 - minutes
Schedule © Text A M EF| =
Dt eiasdoisloy G Preview
Time {24 hour) XXX
Control
| escage Broadeastin - |
® Start settings |
Exit Unzat
L Gmed | « Select File to distribute one JPEG file.

« Select Folder to distribute all JPEG files in the specified folder.

. o Select Text to distribute a text message.
B Select Start, and then select Settings. &

Select the necessary settings.

« When you select File, select Browse to specify the file to be
distributed.

« When you select Folder, select Browse to specify the folder that
includes the files to be distributed. Specify an Update interval setting
from 1 to 30 minutes for automatically switching display from one
image to the next.

« When you select Text, enter the message in the text box and select
any available style settings.

B Select OK.
g Select OK.



Message Broadcasting

Repeat steps 2 to 4 to specify the date and time to finish message
broadcasting.

If you do not specify the date and time to stop message

broadcasting, the projector projects the distributed message
continuously.

m Select Exit, and then select OK.
@ Select Close to save the schedule and message settings.

At the specified date and time, the images or text message you specified is
projected by the selected projectors or groups.



Exporting a Profile for Epson iProjection Software

You can export projector information for a group of projectors registered in
the Epson Projector Management software and import it into the Epson
iProjection software as a profile.

Select File from the menu bar and select Export > Epson iProjection
Profile.

a Select the projector group that you want to export.

B Select OK to save the .mplist file.

@ « See the Epson iProjection Operation Guide (Windows/Mac) for details
on importing projector information into Epson iProjection.

» You may not be able to import the profile correctly depending on the
registered status of exported projectors.



Saving Projector Log Files

You can save selected information such as a projector's usage and error Specify the output folder and file name, and then select Save.
histories to a log file in a folder of your choosing. (Available only for Epson

projectors.) The log file is saved as a separate zip file. The zip file is created to the specified folder.

« Log information is obtained only while the Epson Projector

Management software is running.

+ The Epson Projector Management software saves log information for
the last three months by default. You can change the log saving
period from the Log Save Settings on the Monitor tab of the
Environment setup screen.

« The type of logs saved by the Epson Projector Management software
varies depending on your projector models.

Select File from the menu bar and select Log Save Settings.

The Log Save Settings screen appears.

gLogSaveSetthgs E

Select the items you want to save.

Target projector
@ All projectors
(O Selected projectors

Save Log

Projector Info

Status History (Epsaon projectors only)
Projector Usage History (Epson projectors only)
Service (Epson projectors only)

[ Save ] [ Cancel ]

a Select the target projector.
« Select All projectors to include all registered projectors.

o Select Selected projectors to include only the selected projectors.

Select the type of information you want to save in a log file, and then
select Save.



Updating the Registered Information

When you replace a registered projector, the software automatically detects it
and displays a message. When the message appears, you can update the
registered information.

Any schedule events associated the replaced projector are still enabled.

n On the Epson Projector Management main screen, select the replaced
projector. You can select multiple projectors or all projectors by
selecting checkboxes as necessary.

a Right-click any selected projector in the list, and then select Process
Replaced Projector.

You see a prompt asking if you want to store the history data before
replacing the projector. If you will use the history data for analysis,
select Yes. If not, we recommend selecting No.

If you enabled email notifications, you will receive a confirmation email when
the update is complete.



Solving Problems

See the following sections to check for solutions to problems you may have using the Epson Projector Management software.

» Related Links

« "Solving Network Connection Problems" p.45

« "Solving Monitoring and Controlling Problems" p.47
« "Solving Firmware Updating Problems" p.48



Solving Network Connection Problems

Try these solutions depending on your network environment.

» Related Links
« "Solutions When You Cannot Find Connected Projectors (Wired)" p.45
« "Solutions When You Cannot Find Connected Projectors (Wireless)" p.45

Solutions When You Cannot Find Connected

Projectors (Wired)

When you cannot find the projector over a network using a wired connection,
try the following solutions. If you cannot resolve the problem, contact your
network administrator.

« Connect the network cable securely.

« Use a commercially available 100BASE-TX or 10BASE-T LAN
cable.

« To prevent malfunctions, use a category 5 or higher shielded LAN
cable.

o Check the projector's network settings.

« Set DHCP to Off. When DHCP is set to On, it may take some time to
enter LAN standby status if an available DHCP server is not found.

o Set the IP address, the subnet mask, and the gateway address for the
projector correctly.

o Close the network settings menu on the projector.

o Check the computer's network settings.

« Enable LAN settings on your computer.

o Turn oft the firewall. If you do not want to turn it off, register the firewall
as an exception. Make the necessary settings to open the port. The port
used by this software is "56181" (TCP).

» Related Links
« "Setting Up a Projector to Connect in Advanced Connection Mode (Wired)"
p-11

Solutions When You Cannot Find Connected
Projectors (Wireless)

When you cannot find the projector over a network using a wireless
connection, try the following solutions. If you cannot resolve the problem,
contact your network administrator.

o Check the status of the external devices used for the network connection or
the environment in which the network devices and the projector are located.

« Connect the specified wireless LAN unit to the projector securely, if
necessary. See your projector User's Guide for details.

o Check for any obstacles between the access point and the computer or
projector, and change their position to improve communication.
Sometimes, indoor environments prevent the projector from being found
in a search.

 Make sure that the access point and the computer or projector are not too
far apart. Move them closer together and try to connect again.

o Check for interference from other equipment, such as a Bluetooth device
or microwave. Move the interfering device farther away or expand your
wireless bandwidth.

o Set the radio strength for the network devices to the maximum.

o Set the IP address, the subnet mask, and the gateway address for the
access point correctly.

« Make sure the wireless LAN system of the access point supports the
projector's wireless LAN system.

o Check the projector's network settings.

« Set the Connection Mode setting to Advanced.

o Set the computer, the access point, and the projector to the same SSID.

« Set DHCP to Off. When DHCP is set to On, it may take some time to
enter LAN standby status if an available DHCP server is not found.

o Set the IP address, the subnet mask, and the gateway address for the
projector correctly.

o Turn on the wireless LAN setting, if necessary.

o Set the wireless LAN system to meet the standards supported by the access
point.

« When you enable the security setting, set the same passphrase for the
access point, the computer, and the projector.



Solving Network Connection Problems

o Close the network settings menu on the projector.
o Check the computer's network settings.

» Make sure you are using a computer that can connect to a wireless LAN.

« Enable the wireless LAN setting or AirPort on your computer.

« Connect to the same access point to which the projector is connected.

o Turn oft the firewall. If you do not want to turn it off, register the firewall
as an exception. Make the necessary settings to open the port. The port
used by this software is "56181" (TCP).

» Make sure no access point settings block connections to the projector, such
as MAC Address restrictions or port restrictions.

» Related Links
« "Setting Up a Projector to Connect in Advanced Connection Mode
(Wireless)" p.11



Solving Monitoring and Controlling Problems

Try these solutions depending on your situation.

Solutions When Network Alert Emails are not

» Related Links Received

+ "Solutions When You Cannot Monitor or Control the Projector” p.47

« "Solutions When Network Alert Emails are not Received" p.47 If you do not receive an email alerting you to problems with a projector over
« "Solutions When You Cannot Broadcast a Message" p.47 the network, try the following solutions:

» Make sure the projector is turned on and connected to the network
correctly. (If a critical problem causes a projector to shut down, you may

Solutions When You Cannot Monitor or Control the not receive an email alert.)
Pro jector » To monitor projectors even when they are in standby mode (when power is
off), select Communication On as the Standby Mode setting in the
Try these solutions when you cannot monitor or control the projectors. projector's menus. Also select the correct Port setting, if necessary.

« Make sure the projector is turned on and connected to the network » Make sure your electrical outlet or power source is functioning correctly.

correctly. « Select Test Email on the Mail tab of the Environment setup screen. If you

. . . . do not receive the test email, check all of the settings on the Mail tab for
« To monitor projectors even when they are in standby mode (when power is

off), select Communication On as the Standby Mode setting in the accuracy.
projector's menus. Also select the correct Port setting, if necessary. » Related Links
« Make sure the projector you want to monitor or control is registered to the « "Environment Setup - Mail" p.60

Epson Projector Management software.
o Turn off the DHCP settings for your projector. If you turn on the DHCP

settings, the projector's IP address changes automatically and the Epson Solutions When You Cannot Broadcast a Message
Projector Management software may not be able to search for the registered

projector. If the message broadcasting feature does not work, try the following solutions:
« When you restore settings from the backup file, extract the zip file and copy « Make sure the projector is turned on and connected to the network

the extracted files to the following directory. correctly.

C:\ProgramData\SEIKO EPSON CORPORATION\Epson Projector

 To monitor projectors even when they are in standby mode (when power is

off), select Communication On as the Standby Mode setting in the
. If YOll need to reinstall the software but dO not have a backup file, remove projector's menus. Also Select the correct Port Setting’ lf necessary_

the file stored in the following directory, and then reinstall the software:
C:\ProgramData\SEIKO EPSON CORPORATION\Epson Projector

Management

« In your firewall settings, open the UDP port to allow Message Broadcasting
to communicate through the required port. See your firewall software

Management documentation for instructions.
» Related Links « When you press the [Esc] button on the projector's control panel or remote
« "Environment Setup - General" p.58 control to discontinue message broadcasting, the message broadcasting

« "Monitoring and Controlling the Projectors" p.17 feature is disabled. To distribute messages again, restart the projector.



Solving Firmware Updating Problems

Try these solutions depending on your situation. « When the Windows Security Alert appears and asks you to confirm the
. Firewall setting while searching for the projectors, allow access to the Epson
» Related Links

Proj M f .
« "Solutions When You Cannot Update Firmware or Copy Menu Settings" rojector Management software
p-48

Solutions When You Cannot Update Firmware or
Copy Menu Settings

o Check that the computer is connected to the network.

o Select Enable to receive information about firmware updates on the
Monitor tab of the Environment setup screen.

o Check that the Epson Projector Management software was running at the
scheduled update time.

« If the projector's Standby Mode is set to Communication Off and the
projector is off, the firmware cannot be updated and the menu settings
cannot be copied. Change the Standby Mode to Communication On.

« The firmware or configuration file may be corrupted. Download the
firmware or copy the menu settings again, and then try updating or copying
again.

o If the update is not performed at the specified time, check that the schedule
has not been canceled. Canceled schedules remain in the right pane of the
Update List view and their status reads Finish.

o If the network settings are changed after registering the projector in the
Epson Projector Management software, the firmware cannot be updated
and menu settings cannot be copied because the information for the
projectors registered in the application and the projector's actual settings
differ. Click Refresh on the Update List view to update the projector
information.

« If you cannot update the firmware or copy menu settings on a DHCP
network, disable DHCP and try updating or copying using a fixed IP
address.



Screen Summary

See these sections for more information about the Epson Projector Management screens.

» Related Links

« "Epson Projector Management Main Screen” p.50
« "Projector Properties Screen” p.53

« "Environment Setup Screen" p.58



Epson Projector Management Main Screen

When you start the Epson Projector Management software, the main screen Tool menu

o Application lock/Application unlock: Enables or
appears.

disables the application lock feature.
o Environment setup: Displays the Environment
setup screen.

| | | | :’_'IE- « Schedule: Selects schedule settings.
. iy 5] oo [ AvPuan [ o Message Broadcasting: Selects message broadcasting
ﬁ " X i = ’=: :_f; "; e ox settings.
o E e — — > < Show/Hide Expands or collapses the group list.
= e e e Group List Displays the items registered in the group in a

hierarchical diagram.

(2]

©

@ |Source Switches the projector's input source. (Available only
for Epson projectors.)

@ |A/V Mute Turns the projector's A/V Mute or Shutter feature on
or off.

@ |Power Turns the projector power on or off.

v (7 f::; Updates the projector information.

@ | File menu Displays the update list view. You can manage

projector firmware updates and the batch setup
operations.

 Log Save Settings: Selects the log file settings.

Be

« Export: Exports projector information registered in
the Epson Projector Management software so you
can import it into the Epson iProjection software.

Displays the error list. You can check a list of only
projectors that are currently in an error or warning
status.

« Version information: Displays the application
version information.

sl

« Exit: Closes the application.

Project (10) Displays the grouping view. You can check the
rojector menu Projector Registration: Searches for and registers FEW projector group in a hierarchical diagram.
new projectors.

« Group Registration: Creates new projector group.

® Displays detail list view. You can check the projector
Edit menu . . . o — !
 Property: Displays the Projector properties screen. H— status as a list.

» Monitoring enabled/Monitoring disabled: Enables
or disables monitoring.

o Delete: Removes the selected projector from the list.

» Related Links
« "Projector Status Icons" p.51




Epson Projector Management Main Screen

« "Update List View" p.52
« "Environment Setup - Display List" p.59

The projector is cooling down.

Projector Status Icons

The icons in the Epson Projector Management main screen are described in
the following table.

The projector power is off.

The projector had a problem and shut down.

The projector's A/V Mute or Shutter feature is turned on.

The group is expanded.

The group is collapsed.

The projector is monitored or controlled using the PJLink
protocol.

[mmmmm| | The projector is too hot.

[T 1 | The projector is overheated.

/1

[ ] | The projector's temperature level is normal.
= ]

The group or projector is in normal status.

The software cannot acquire the status of projector.

The group or projector is in warning status.

The group or projector is in error status.

The group or projector requires immediate attention.

The group or projector performs operations.

Updating the group or projector information.

Monitoring is disabled for the group or projector.

The projector power is on.

ST o (W 5[5[8[B[B] 8]5[@ »

The projector is warming up.




Epson Projector Management Main Screen

Update List View

When you click the Update List icon on the Epson Projector Management
main screen, the Update List view appears. You can update your projectors to
use the latest firmware or copy the projector's menu settings.

(5] ?_

Fie Propcer Bde Tool

3 — & iﬂ 0 Powers aAlMuee o

0 ——G= A K &
A =
lou,g = e L] o R oo ST
" L i - [ S

Update

oo o (1
K

@ | Select File Selects the firmware file or the menu setting
configuration file.

@ | Right Now Starts the firmware update or projector menu copying
process immediately.

@ | Schedule Schedules the date and time to start the firmware
update or projector menu copying process.

@ |Delete Deletes update schedules.

@ |Edit Edits an update schedule.




Projector Properties Screen

When you select Property in the Edit menu, the Projector properties screen To update the projector information, select © .

appears.

» Related LinkS .‘glﬁ Scbedz::perﬁesl. = Status Information | Service -@
« "Projector Properties - Information” p.53 Information | Statushistory | Usage History

« "Projector Properties - Status History" p.54

« "Projector Properties - Usage History" p.55

« "Projector Properties - Schedule" p.55

« "Projector Properties - Status Information” p.56
"Projector Properties - Service" p.57

Display name OO0 | ©
Projector name

Icons [“or] Select... |

Group name No Group Select...

1P address
Light scurce hours used  -—---

Source

Projector Properties - Information ol

Constant Brightness
Remains

Temperature level

When you select the Information tab on the Projector properties screen, the
following screen appears. The information acquired from the projector varies
depending on the projector model. If the software cannot acquire

Manufacturer

Medel

information, it displays it as "---". pessnpen
Status Network error (TCP connection error)
Monitor Password
| cancel
Display name Displays the name used in the Epson Projector Management
software.

Projector name Displays the name that has been registered to the projector.
Icons Displays the icons registered for the projector or group. You

can change icons using the Select button.

Group name Displays the group name that the projector belongs to. You
can change the group using the Select button.

IP address Displays the projector's IP address.

Light source hours | Displays the number of hours the projector's light source has
used been used.




Projector Properties Screen

Source Displays the projector's current input source. When you select Projector Management software is running. To output the error history as a
a non-Epson projector, you can specify the number of the csv file, select Save.
input source to switch sources.
Light Source Displays projector's light source. 5 Profector properties (000000
Schedule | Status Information | Service
Constant Displays the remaining time that the projector can maintain Information || StetusHstory | Usage History
Brightness Remains | constant brightness. (Available only when Constant Status History
Brightness is set to On in the projector’s light source setting . :
menu ) Error Type  Date/Time of-- Date/Time of - Status

Temperature level | Displays the projector's temperature in five levels.

Manufacturer Displays the projector's manufacturer.

Model Displays the projector's model name.

Description Displays notes about the projector.

Status Displays the projector's error information. To view solution,

move the pointer over the error information.

Password If computer/projector authentication fails and you have set a
password for the projector, enter your password here to access
the projector settings.

Projector Properties - Status History -

When you select the Status History tab on the Projector properties screen,
the following screen appears. You can check errors that occur while the Epson



Projector Properties Screen

Projector Properties - Usage History

Projector Properties - Schedule

When you select the Usage History tab on the Projector properties screen, When you select the Schedule tab on the Projector properties screen, the

the following screen appears.

¥ Projector properties (30C00MX)

Schedule |

Status Information I

Service

Information | Status History

Usage History

Projector Usage History

< | 2017/8

»

Date
1

following screen appears.

You cannot schedule a firmware update on this screen. Schedule it in

T T T T T T T T T
Q 4 g 12 16 20 24
Time[H]

Other times: OH

s

| Previous Month

Displays a graph of the previous month.

| * Next Month

Displays a graph of the next month.

Save

Outputs the currently displayed history as a csv file.

Other times

Displays the number of hours the projector has been used
without monitoring by the Epson Projector Management
software.

the Update List view.
g] » — = el
‘ Information | Status History | Usage History
Schedule i Status Information | Service
~ ) Calendar
|« August, 2017 »
Su Mo Tu We Th Fr  Sa
30 31 1 2 3 4 5
6 7 8 9 10 11 12
13 14 15 16 17 18 18
20 21 22 23 24 25 26
27 29 30 31 1 2
3 4 5 6 7 S 9
Schedule
Icons Display n-- Date Hour Contral
add | |
[ Goesi ]

DE Show/Hide

Displays or hides the calendar.




Projector Properties Screen

Calendar Today's date appears with a highlighted background and white projector varies depending on the projector model. If the software cannot
text. A scheduled date appears with a highlighted background acquire information, it displays it as "---".
and black text. Select * to move to the previous month or
year and select ¥ to move to the next month or year. = Pmi::::;z:::mes ———
Schedule Displays the schedule list. The color of the row is described as Schedule ), St nformaton | sSenvice
follows. :
. |:|: Enabled schedule e
Source
. : Disabled schedule On-ScreenDisplay
. -: Unselected schedule Shuter
Air Temp.
Temp level
@ « You can duplicate the schedule by right- - \nge
clicking the schedule and selecting Copy e
and Paste. i
Lamp Status
« Firmware update schedules are not -
displayed in this list. Open the Update
List view to see the firmware update
schedules.
Enabled Enables the selected schedule.
Disabled Disables the selected schedule.
Add Creates a new schedule.
Edit Edits the selected schedule.
Delete Removes the selected schedule.
XKX0000K =| | Switches the displayed information from the following list.
» Related Links Status Information |« Status Information
« "Scheduling Projector Events" p.33 * Source
« "Updating Firmware and Copying Menu Settings" p.24 « Network Wired
« Network Wireless
» Maintenance
Projector Properties - Status Information » Version
s Update Updates status information.
When you select the Status Information tab on the Projector properties

screen, the following screen appears. The information acquired from the



Projector Properties Screen

Projector Properties - Service

When you select the Service tab on the Projector properties screen, the
following screen appears. (Normally used only by Epson Support.)

B Projector properties (XXXXXXX) (3l
Information | Status History | Usage History |
Schedule | Status Information | Service

This item is for service personnel.

Sarvice Info : v] \E‘ | save |

Cannot obtain data because the process monitoring the projector is invalid

m ] »

cancs




Environment Setup Screen

When you select Environment setup in the Tool menu, the Environment
setup screen appears.

» Related Links

« "Environment Setup - General" p.58

« "Environment Setup - Monitor" p.59

« "Environment Setup - Display List" p.59
« "Environment Setup - Mail" p.60

Resident in the task
tray

Continues monitoring when you close or minimize the Epson
Projector Management window. The icons displayed on the
task bar are described below.

. Ez Normal operation.

. il-: Warning or error occurred.

Environment Setup - General

When you select the General tab on the Environment setup screen, the
following screen appears.

Set the projector's
Standby mode to
Communication
On when
registering

Sets the Standby Mode setting to Communication On in the
projector's menu during projector registration (Epson
projectors only).

Save Configuration
File

Creates a backup of the configuration file by selecting Save.
When you restore settings from the backup file, extract the zip
file and copy the extracted files to the following directory.

C:\ProgramData\SEIKO EPSON CORPORATION\Epson
Projector Management

= Environment setup X
General | Monitor | Display List | Mail |
Application lock
[] Register at startup
[] Resident in the task tray
Set the projeCtor's Standby made to Communication On when registering
Save Configuration File
Application lock Changes password for the application lock feature by selecting
Password.
Register at startup | Starts the Epson Projector Management software automatically
when you start up the computer.




Environment Setup Screen

Proxy Settings Select Settings to set up proxy server settings. In the Proxy
Settings window, select Use a proxy server and enter the
proxy server's information (Address, Port Number, User

name and Password).

Environment Setup - Monitor

When you select the Monitor tab on the Environment setup screen, the
following screen appears.

Log Save Settings | Specifies the length of time for which to save the log of
Projector Usage History and Status History from 1 to 99

months.

X

2 Environment setup

General| Monitor | Display List | Mail

A 5 H s Temperature Select to display the temperature information graph.
[] Temperature level display group view hist ory

[ Lamp schedule notification Qo0 H o

Enable to recemve mnformation about firmware updates

Last Checked : 1000(/200%X

Mot pedriotuote Environment Setup - Display List

Praxy Settings Settings...

Log Save Settings

When you select the Display List tab on the Environment setup screen, the

Pl Ugage trsion/ » = o following screen appears.
Status History 3 = Month
Temperature history B cnvironment setup X

General | Monitor | Display List | Mail

List Type

® Detail list view

) Error list
[ox | > Update s
List Item
Displayable items Selected ltems and Order
Select All/Clear All lcons:
Update interval Specifies the update interval of the projector information from Light source howrs used Group name
1 to 99 minutes. When you monitor a large number of oo i
projectors, specify a longer interval so that the update can MAC Address o] | power
. . . Serial Number AN Mute
finish during that time. i o
R A A . . Manufacturer = Temperature level
Temperature level | Displays the projector temperature level in the Grouping view. Model Shniion
: . Canstant Brightness Remains
display group view ol
Lamp schedule Specifies when you receive a projector status notification based
notification on the number of hours the light source has been used. e
Enable to receive | Select to receive notification of available firmware updates. [T

information about
firmware updates

You can select Check to see if firmware updates are available
for the registered projectors or not.

Send operation log
information

Specifies whether to send projector log information to Epson
or not.

List Type

Select the type of list for which you want to change the
displayed items and order: Detail list view, Error list, or
Update List.




Environment Setup Screen

List Item Select the items you want to display or remove from display, Use Email Select to send an email to the preset addresses when a
and arrange their order. Displayable Items are available for Notification System | projector status changes.
adding to the Selected Items and Order list. SMTP Server Enter the SMTP server name or IP address for the SMTP
« " : Displays the item selected in Displayable Items. server.
« . Hides the item selected in Selected Items and Order. Port Number zglse?f; a])nufmtl)e? fg; the SMTP server port number using 1 to
| . Default is 25.
« | 1. Moves the item selected in Selected Items and Order to 0 ol henticatl
the previous position. Xsil;FLi ; Select to enable TLS authentication.
| uthentication
« | *: Moves the item selected in Selected Items and Order to Use SMTP Select fo enable SMTP authentication
the next position. Authentication ’
" User name Enter a user name for the SMTP authentication.
Related Links
Password Enter a password for the SMTP authentication.

« "Monitoring Projectors” p.18
Sender mail address | Enter the email address of the sender. You can enter up to 512
alphanumeric characters.

. . Target Email Displays the recipient's email addresses.
Environment Setup - Mail g il P
Address
When you select the Mail tab on the Environment setup screen, the Add Adds a new recipient's email address.
following screen appears. Edit Edits the selected recipient's email address.
—yr— % Test Email Sends a test email to the selected recipient's email address.
Sons | i} Dbty Lt Ml Delete Removes the selected recipient's email address.
[] Use Email Notification System
Mail Server
el » Related Links
e « "Sending Email Notifications" p.36

Use TLS Authentication
Use SMTP Authentication

User name
Password

Sender mail address

Target Email Address




Appendix

See these sections to learn more about the Epson Projector Management software.

» Related Links

« "Updating and Uninstalling the Software" p.62

« "PJLink Monitoring and Control Limitations" p.63
 "Notices" p.64



Updating and Uninstalling the Software

Follow these instructions to update or uninstall the Epson Projector
Management software.

» Related Links

« "Getting the Latest Version of the Software" p.62

« "Uninstalling the Epson Projector Management Software (Windows
8.1/Windows 10)" p.62

Getting the Latest Version of the Software

Updates to this software and its guide may be available on the Epson Web
site.

Visit epson.sn.

Uninstalling the Epson Projector Management
Software (Windows 8.1/Windows 10)

Follow the instructions below to uninstall the Epson Projector Management
software.

You need administrator authority to uninstall the software.

Turn on your computer.

Make sure all running applications are closed.

Press the E key on the keyboard to display all apps.

Right-click (press and hold) Epson Projector Management Ver.X.XX,
and then select Uninstall.

Follow the on-screen instructions.


http://www.epson.sn

PJLink Monitoring and Control Limitations

The following features are not available when you monitor or control the
projector using the PJLink.

« Automatic search (for PJLink Class1 projectors)
« Source button on the main screen

o Schedule

« Email Notification

» Message Broadcasting

« Log Save Settings (except for Projector Info)

« Firmware update

» Menu settings copying

« Detecting replacement of registered projectors

The following information cannot be acquired from non-Epson projectors.

« Light source hours used

« Constant Brightness Remains
» Temperature level

« Status History

 Usage History

« Status Information

« Service

 Temperature history



Notices

Check these sections for important notices about your software.

» Related Links

« "Copyright Notice" p.64

« "About Notations" p.64

« "General Notice" p.64

« "Copyright Attribution” p.64

In this guide, the operating systems above are referred to as "Windows 8.1"
and "Windows 10". Furthermore, the collective term "Windows" is used to
refer to them all.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a
retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written
permission of Seiko Epson Corporation. No patent liability is assumed with
respect to the use of the information contained herein. Neither is any liability
assumed for damages resulting from the use of the information contained
herein.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the
purchaser of this product or third parties for damages, losses, costs, or
expenses incurred by the purchaser or third parties as a result of: accident,
misuse, or abuse of this product or unauthorized modifications, repairs, or
alterations to this product, or (excluding the U.S.) failure to strictly comply
with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or problems
arising from the use of any options or any consumable products other than
those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.

The contents of this guide may be changed or updated without further notice.

Ilustrations in this guide and the actual projector may differ.

General Notice

EPSON is a registered trademark, and EXCEED YOUR VISION and its logo
is registered trademark or trademark of Seiko Epson Corporation.

Microsoft, Windows, Windows logo, and SQL Server are trademarks or
registered trademarks of Microsoft Corporation in the United States and/or
other countries.

Intel is a registered trademark of the Intel Corporation in the U.S. and/or
other countries.

Other product names used herein are also for identification purposes only
and may be trademarks of their respective owners. Epson disclaims any and
all rights in those marks.

Software Copyright: This product uses free software as well as software to
which this company holds the rights.

About Notations

« Microsoft Windows 8.1 operating system

« Microsoft Windows 10 operating system

Copyright Attribution

This information is subject to change without notice.
© 2021 Seiko Epson Corporation
2021.4 414138400EN
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